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Введение
Данное методическое пособие предназначено для студентов, обучающихся по специальности 230115 Программирование в компьютерных системах  и направлено на формирование у них профессиональных компетенций:
ПК 1.6 Разрабатывать компоненты проектной и технической документации с использованием графических языков спецификаций.
ПК 3.1 Анализировать проектную и техническую документацию на уровне взаимодействия компонент программного обеспечения.
[bookmark: _GoBack]ПК 4.2 Выполнять ввод цифровой и аналоговой информации в персональный компьютер с различных носителей.
ПК 4.4 Обрабатывать аудио и визуальный контент средствами звуковых, графических и видео-редакторов.

Исходя из структуры и содержания методического пособия, оно будет полезно следующим категориям читателей:
· студентам технических специальностей колледжей и вузов, изучающим прикладные программы;
· преподавательскому составу, осуществляющему  теоретическую подготовку студентов по дисциплине «Пакеты прикладных программ»;
· преподавателям иных дисциплин, использующим персональные компьютеры в качестве технического средства обучения и (или) средства подготовки учебно-методических материалов (бумажных и электронных) по своей предметной области;
· лицам, самостоятельно изучающим или осваивающим дисциплину «Пакеты прикладных программ»;







Особенности CorelDraw

Векторный графический редактор CorelDraw канадской фирмы Corel Corporation получил известность благодаря широким возможностям, наличию огромных библиотек готовых изображений, мощной встроенной системе обучения и подсказок, верной маркетинговой политике разработчика. Некоторые средства. Программа предоставляет пользователю удобные и интуитивно понятные средства создания и редактирования графики. 
В целом интерфейс CorelDraw выполнен в традициях, ставших стандартом  для приложений в операционной системе Windows. To есть, окно программы имеет стандартные элементы: строку заголовка с соответствующими кнопками, строку меню, строку состояния, панель инструментов, другие панели, состав которых может определять пользователь, полосы прокрутки и прочее. Однако интерфейс CorelDraw имеет и свои особенности, отличающие его от других программ.
Начиная с восьмой версии появился особый тип элементов управления — Dockers, или стыкуемые палитры. Такие палитры обладают свойством «приклеиваться» при перетаскивании мышью к одной из сторон рабочего поля или друг к другу с образованием вкладок. Заголовок окна палитры содержит закрывающую и сворачивающую кнопки. Удобство применения стыкуемых палитр заключается в том, что при их сворачивании (раскрытии) автоматически изменяется размер рабочего поля и пользователю нет необходимости вручную масштабировать вид изображения, что требуется в других программах.
Уникальными интерактивными свойствами обладает Property Bar (Панель свойств). Состав ее элементов управления динамически меняется в зависимости от типа выбранного объекта. То есть, при выборе текста на панели свойств появляются элементы управления свойствами текста, при выборе линии — элементы управления свойствами линии и т. д. Тесно связаны с панелью свойств интерактивные средства управления заполнением, параметрами контуров и прочими свойствами объектов. Их вызов осуществляется из раскрывающегося меню, появляющегося после щелчка правой кнопкой мыши на выбранном объекте.

[bookmark: _Toc43451728] Настройка параметров CorelDraw

Для удобной и эффективной работы в CorelDraw прежде всего необходимо настроить параметры программы в соответствии с решаемыми задачами и предпочтениями пользователя. Возможности настройки поистине уникальны и не имеют аналогов в других графических программах. Все настройки, выбираемые командой Tools > Options (Сервис > Параметры), подразделяются натри основных раздела (рис. 1). Раздел Workspace (Рабочая область) содержит средства управления параметрами интерфейса; раздел Document (Документ) позволяет управлять свойствами разрабатываемого проекта; средствами раздела GlobaJ (Глобальное) управляют параметрами взаимодействия редактора с аппаратными устройствами и другими внешними компонентами.
[image: ]

Рис. 1. Настройка интерфейса и параметров CorelDraw

ГЛОБАЛЬНЫЕ ПАРАМЕТРЫ
Настройку лучше всего начинать именно с глобальных параметров. Раздел Color Management (Управление цветами) содержит элементы управления отображением и преобразованием цвета на мониторе и внешних аппаратных устройствах (сканеры, принтеры и прочие). При подготовке цветных публикаций следует внимательно ознакомиться с установками, используемыми по умолчанию, и при необходимости изменить параметры настройки в соответствии с собственными аппаратными средствами и особенностями публикации. На вкладке Profiles (Конфигурации) устанавливают цветовые профили, соответствующие используемым аппаратным средствам. Необходимый цветовой профиль выбирают из списка, загружают с внешнего носителя или через Интернет. В последнем случае при наличии подключения к Интернет достаточно щелкнуть на кнопке Color Profiles Online (Цветовые профили в сети) и получить доступ к библиотеке профилей. Однако эта услуга платная. Наконец, при отсутствии специализированного цветового профиля можно указать сгенерированный профиль, используемой системой управления цветом Eastmen Kodak Digital Science ICC, применяемой в CorelDraw.
Раздел Printing (Печать по умолчанию) содержит элементы управления процессом печати и подготовки публикации. Следует обратить внимание на вкладку Pref light (Проверка перед печатью), если планируется вывод на устройства PostScript. Сбросом или установкой флажков задают параметры, контролируемые программой при проверке документа PostScript.
Установкой переключателей на вкладке Bitmaps Effects (Эффекты растрового изображения) задают параметры предварительного просмотра изображения на экране.
Вкладка Filters (Фильтры) содержит обширный список фильтров, используемых для операций импорта-экспорта растровой и векторной графики, а также текста в различных файловых форматах. Имеется возможность добавлять или удалять отдельные фильтры по желанию пользователя. Вкладка Associates (Ассоциировать) позволяет связывать расширения имен файлов с конкретным форматом документов.

ПАРАМЕТРЫ ИНТЕРФЕЙСА
Настройку интерфейса проводят на вкладках раздела Workspace (Рабочая область). Заглавная вкладка позволяет выбрать стиль интерфейса, установленный по умолчанию, либо аналогичный программам Adobe Illustrator или Macromedia FreeHand, либо создать собственный стиль.
На вкладке General (Общие) выбирают количество операций, подлежащих отмене: Undo Levels (Уровни отмены), параметры отображения диалоговых окон, звукового оформления и некоторые другие параметры.
На вкладке Display (Монитор) переключателями устанавливают параметры отображения графики на экране.
Вкладка Edit (Изменение) содержит несколько окон с переключателями, полями, счетчиками и списками, где устанавливают смещение дубликатов объектов, параметры узлов, точность позиционирования графики и другие свойства.
На вкладке Warning (Предупреждения) установкой (сбросом) флажков регулируют отслеживаемые параметры, при нарушении которых выдается предупреждение.
Вкладка Save (Сохранить) содержит средства управления сохранением резервного файла публикации.
На вкладке Memory (Память) задают первичный и вторичный рабочие диски и устанавливают предельный объем оперативной памяти, монопольно используемый CorelDraw.
На вкладке Plug-Ins (Подключения) отображается расположение файлов внешних расширений. Там же можно подключить расширения, совместимые с CorelDraw.
Вкладка Text (Текст) двухуровневая. Заглавная вкладка содержит элементы управления общими свойствами текста, например принятыми единицами измерения размера шрифта. Вложенные вкладки Paragraph (Абзац), Fonts (Шрифты), Spelling (Проверка правописания), Type Assistant (Автозамена) позволяют управлять соответствующими атрибутами текстовых объектов.
Обширная группа Toolbox (Графика) объединяет пятнадцать вкладок управления свойствами различных инструментов, например Knife Tool (Нож), Eraser Tool (Ластик), Ellipse Tool (Эллипс) и прочими.
С точки зрения настройки интерфейса под нужды пользователя, большое значение имеет двухуровневая группа вкладок Customize (Настройка). На заглавной вкладке в окне Toolbars (Панели инструментов) установкой (сбросом) флажков выбирают отображаемые панели инструментов.

На вкладке Shortcut Keys (Клавиши быстрого вызова) представлен полный список «горячих» клавиш, используемых по умолчанию. Пользователь может по собственному выбору назначить любой команде (операции) собственное сочетание «горячих» клавиш. При этом программа отслеживает возможные конфликты с уже используемыми сочетаниями и предлагает их устранить. С помощью элементов этой вкладки можно создать собственную «библиотеку» команд быстрого доступа к средствам и элементам управления CorelDraw.
Другим мощным средством настройки интерфейса являются элементы вкладки Menus (Меню). В ее левом окне расположены все команды, доступные в CorelDraw, в правом — список всех меню, открываемых как из строки меню, так и другими способами (например, по щелчку правой кнопкой мыши). Любую команду можно разместить в любом меню на любом уровне. Таким образом становится возможным создание индивидуальных уникальных интерфейсов, настроенных на конкретные задачи.
Подобным способом организовано управление интерфейсом и на вкладке Toolbars (Панели инструментов). Только в этом случае объектом управления выступают инструментальные кнопки, а субъектом — любая инструментальная панель. То есть можно создавать собственные уникальные наборы инструментов, появляющиеся на панели при выборе объекта соответствующего типа.
На вкладке Color Palette (Цветовая палитра) определяют параметры отображения стандартных цветовых палитр, а на вкладке Link Manager (Ссылки) указывают параметры проверки правильности адресов и устойчивости связи при наличии в документе ссылок на ресурсы сети Интернет.

ПАРАМЕТРЫ ДОКУМЕНТА
Вкладка Document (Документ) имеет три уровня. На заглавной вкладке установкой флажка Save options as default for new document (Сохранить параметры, как действующие по умолчанию для новых документов) задают сохранение параметров как используемых по умолчанию для всех последующих документов. Дополнительные настройки (какие именно параметры следует сохранять) указывают установкой соответствующих флажков.
На вкладке General (Общие) определяют параметры рендеринга векторных объектов при их отображении на экране, принятый по умолчанию режим визуализации, а также режимы заливки открытых кривых и применения эффектов к растровым изображениям.
Вкладка Page (Страница) позволяет установить режимы показа некоторых элементов страницы, например отображение границ листа.
На вкладке Size (Размер) устанавливают размер страницы, выбирая из списка стандартных форматов или устанавливая собственные параметры.
Вкладка Layout (Макет) предоставляет возможность выбрать режим отображения страниц. В частности, можно представлять страницы как элементы листа полиграфического формата с учетом выбранного способа его фальцовки.
На вкладке Label (Метка) указывают параметры наклейки, автоматически присоединяемой к каждой странице.
На вкладке Backgrounds (Фон) задают параметры фонового изображения, занимающего все пространство страницы.
Двухуровневая вкладка Guidelines (Направляющие) в заглавном окне позволяет задать показ направляющих и выравнивание по ним объектов, а также выбрать цвета для заранее установленных и созданных в процессе работы направляющих.
На вкладках Vertical (Вертикальные) и Horizontal (Горизонтальные) задают положение соответственно вертикальных и горизонтальных направляющих, на вкладке Slanted (Косые) — косых направляющих. Элементы вкладки Presets (Внешние) управляют отображением стандартных направляющих, например для границ листа или области печати.
Вкладка Grid (Сетка) содержит элементы управления так называемой «сеткой» — регулярно расположенными на странице точками, являющимися опорными для создаваемых объектов. Плотность сетки можно задать указанием ее частоты (в единицах на миллиметр) или расстояний между соседними точками по вертикали и горизонтали. Установка флажка Snap to grid (Привязывать к сетке) приводит к автоматической привязке узлов объекта к ближайшим опорным точкам.
На вкладке Rulers (Линейки) устанавливают параметры вспомогательной измерительной линейки, располагающейся по краям рабочего поля.
Вкладка Styles (Диспетчер стилей) открывает доступ к атрибутам текста, оформленного различными стилями. Само содержание элементов управления стилями практически не отличается от принятого для текстовых редакторов или программ верстки — можно менять тип и размер шрифтов, начертание, интерлиньяж, позицию и другие атрибуты текста.
На вкладке Save (Сохранить) выбирают некоторые специфические параметры сохранения файлов в формате CorelDraw. Например, примененные в документе текстуры можно сохранить в файле, а можно загружать из редактора при открытии файла. В последнем случае размер файла существенно уменьшается.
Двухуровневая вкладка Publish to Internet (Публиковать в Интернете) содержит специфические элементы управления параметрами подготовки документа для публикации в сети Интернет.

[bookmark: _Toc43451729]Совместное использование панелей
[bookmark: _Toc43451730]инструментов, свойств, интерактивных средств

Средства создания и модификации объектов CorelDraw подразумевают тесное взаимодействие различных элементов управления, присутствующих в программе. Прежде всего, это панель инструментов, панель свойств и интерактивные меню. В принципе, с их помощью можно создавать любые объекты — от простейших фигур до сколь угодно сложных композиций, не прибегая к другим элементам управления программы.
Панель инструментов
Панель инструментов расположена у левого края рабочего пространства и 
объединяет инструменты выбора объектов Pick Tool (Указатель), изменения формы Shape Tool (Фигура), масштабирования Zoom Tool (Масштаб), рисования линий BezierTool (Кривая Безье), рисования прямоугольников Rectangle Tool (Прямоугольник), рисования эллипсов Ellipse Tool (Эллипс), рисования многоугольников Polygon Tool (Многоугольник), работы с текстом Text Tool (Текст). Далее расположена группа интерактивных инструментов: Fill Tool (Интерактивный инструмент Заливка), управляющий способами заливки объектов; Transparency Tool (Интерактивная прозрачность), управляющий прозрачностью объектов; Blend Tool (Интерактивное перетекание), управляющий перетеканием объектов друг в друга с промежуточной трансформацией. Последними на панели размещены инструменты Eyedropper Tool (Пипетка), предназначенный для выбора цвета; Outline Tool (Абрис), управляющий параметрами контуров; Fill Tool (Заливка), управляющий параметрами заливки. Последний инструмент не следует путать с его интерактивным подобием—он выполняет несколько другие функции.
[image: ]Некоторые элементы управления из представленных на панели инструментов имеют альтернативные варианты. Рядом с их обозначением помещен значок раскрывающей кнопки. При щелчке на нем разворачивается вложенная панель, содержащая набор дополнительных инструментов. Если зацепить такую панель мышью, то ее можно перетащить в любое место рабочего поля и разместить как отдельное «плавающее» окно или добавить в область панелей инструментов под строкой меню.

ПАНЕЛЬ СВОЙСТВ
После выбора любого инструмента панель свойств отображает его свойства и предоставляет набор элементов, позволяющих управлять параметрами инструмента или свойствами объекта. В связи с этим панель свойств динамически меняется в зависимости от выбранного инструмента и объекта.
Параметры страницы. Если не выбран ни один объект, на панели свойств присутствуют элементы управления параметрами текущей страницы: раскрывающийся список Paper Type/Size (Тип/Формат бумаги) для выбора стандартного или пользовательского формата страницы; счетчики Width and Height (Высота и ширина бумаги) для установки высоты и ширины страницы; кнопки Portrait (Книжная) и Landscape (Альбомная) для изменения ориентации страницы; кнопки переключения параметров текущей страницы, принятых по умолчанию для всех публикаций или только для текущего документа; раскрывающийся список Drawing Units (Единицы измерения) для выбора единиц измерения; счетчик Nudge Offset (Перемещение клавишами курсора) для задания стандартной величины смещения узлов; счетчики Duplicate Distance (Расстояние до копии) для установки величины смещения дубликата объекта по осямх, у; кнопки Snap to Grid (Привязка к сетке), Snap to Guidelines (Привязка к направляющим) и Snap to Object (Привязка к объектам) для включения режимов выравнивая по опорным точкам, направляющим линиям или выбранному объекту соответственно; кнопка включения режима полного режима отображения объекта при его перемещении или трансформации Draw Complex Objects when Moving or Transforming (Отображать объекты при перемещении); кнопка включения режима Treat As Filled (Считать заполненным); кнопка открытия диалогового окна Options (Параметры) для настройки параметров программы.
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Рис. 2. Панель свойств в режиме управления свойствами страницы

АЛЬТЕРНАТИВНЫЕ ВАРИАНТЫ СРЕДСТВ ПАНЕЛИ ИНСТРУМЕНТОВ
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В группу Shape Tool (Фигура) входят альтернативные варианты Knife Tool (Нож) — предназначен для расчленения объектов по линии разреза; Eraser Tool (Ластик) — служит для удаления части объекта; Free Transform Tool (Свободное преобразование) — позволяет осуществлять свободную трансформацию объектов — вращение, масштабирование, наклон и прочие операции.
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В группу Zoom Tool (Масштаб) дополнительно включен инструмент Pan Tool (Панорама), с помощью которого можно перемещать область видимости по всему рабочему полю. По сути дела он является удобной альтернативой полосам прокрутки.
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Группа Bezier Tool (Кривая Безье) включает инструменты: Freehand Tool (Кривая) — предназначен для рисования линий «от руки»; Artistic Media Tool (Натуральное перо) — служит для имитации рисования пером постоянной или переменной толщины; Dimension Tool (Инструмент Размер) — используется для простановки размерных линий и обозначений на чертежах; Connection Line Tool (Соединительная линия) — применяется для рисования прямых линий, соединяющих два объекта (например, на схемах электрических соединений); Interactive Connector Tool (Интерактивное соединение) — служит для соединения объектов линиями, которые привязываются к объектам и перемещаются вместе с ними.
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Группа Polygon Tool (Многоугольник) объединяет средства рисования как собственно многоугольников (частным случаем считается звезда), так и другие интерактивные инструменты: Spiral Tool (Спираль) для рисования симметричных и логарифмических спиралей; Graph Paper Tool (Разлиновать бумагу) для рисования разграфленных на одинаковые элементы прямоугольных объектов.
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Группа интерактивных инструментов заливки включает собственно средство интерактивной заливки Interactive Fill Tool (Интерактивный инструмент Заливка), с помощью которого выполняют равномерную или градиентную заливку, заполнение узорами, текстурами или объектами PostScript, и инструмент Interactive Mesh Fill Tool (Интерактивная заливка по узлам), который позволяет редактировать заливку, разбивая ее область на отдельные сегменты, ограниченные опорными точками. Смещение опорных точек приводит к распространению заливки, характерной для элемента, в направлении модификации.
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Группа интерактивных средств модификации объектов Interactive Blend Tool (Интерактивное перетекание) позволяет задать перетекание (переход) одного объекта в другой с заданным числом промежуточных трансформаций. Interactive Contour Tool (Интерактивный ореол) служит для создания дубликатов контуров объекта, размещаемых с масштабированием и смещением относительно оригинала. В зависимости от направления смещения (к центру объекта или вовне) дубликаты образуют внутренний или внешний ореол. Инструмент Interactive Distortion Tool (Интерактивное искажение) воздействует на выбранный объект с применением эффектов Push and Pull (Расслоение), Zipper (Зигзаг) или Twister (Смерч) по выбору пользователя. Interactive Envelope Tool (Интерактивная оболочка) позволяет модифицировать контуры объектов, направляя их по выбранной пользователем огибающей, или просто перемещением опорных точек. Инструмент Interactive Extrude Tool (Интерактивное выдавливание) служит для «выдавливания» плоских объектов по третьей координате, образуя псевдотрехмерное изображение. Interactive Drop Shadow Tool (Интерактивная падающая тень) создает эффект тени, отбрасываемой выбранным объектом. Хотя тень является отдельным растровым объектом, изменения, вносимые в оригинал, отражаются и на его тени.
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Инструменты Eyedropper Tool (Пипетка) и PaintbucketTool (Краска) образуют самостоятельную пару. Первый из них позволяет выбрать цвет контура или элемента запивки объекта в качестве текущего. Затем эти параметры можно применить к другим объектам с помощью инструмента Paintbucket Tool (Краска).
Группа настройки параметров контуров и заполнения состоит из двух инструментов, рассмотренных ниже. Они отличаются тем, что воздействуют не только на выбранный объект, но и устанавливают общие для вновь создаваемых объектов атрибуты. Раскрывающая кнопка рядом со значками этих инструментов предоставляет доступ не к альтернативному набору, а к вложенной панели инструментов. Если в документе не выбран ни один объект, щелчок на значке этих инструментов вызывает диалоговое окно, в котором выставлением флажка следует указать, к объектам какого типа (графическим или текстовым) необходимо применить задаваемые параметры.
В диалоговом окне Outline Pen (Атрибуты абриса выбирают толщину контура с помощью счетчика Width (Толщина), цвет контура с помощью текущей палитры Color (Цвет), тип линии в раскрывающемся списке Style (Стиль), задают форму контура на угловых и концевых точках переключателями Corners (Углы) и Line Caps (Концы линий), указывают форму начального и конечного маркеров на концевых точках незамкнутых кривых в группе Arrows (Наконечники), определяют толщину линии при различных углах ее наклона в группе Calligraphy (Каллиграфия). Атрибуты Style (Стиль), и Arrows (Наконечники) можно изменять самостоятельно, редактируя уже готовые элементы или создавая новые. Установкой флажка Scale with image (Сохранять пропорции) задают необходимость пропорционального масштабирования толщины контура при изменении размеров объекта, выставлением флажка Behind fill (Заливка выше абриса) назначают расположение контура всегда поверх заполнения.
Диалоговое окно Outline Color (Цвет абриса)  открывается при щелчке на второй кнопке раскрывающейся палитры инструментов Outline Tool (Абрис). Оно содержит мощные средства выбора и редактирования цвета, расположенные на вкладках Models (Просмотр цветов), Mixers (Смесители), Fixed Palettes (Фиксированные палитры) и Custom Palettes (Пользовательские палитры). С практической точки зрения очень важным является богатый выбор стандартных цветовых палитр фирмы Pantone (применяемых в полиграфии) на вкладке Fixed Palettes (Фиксированные палитры).
Параметры заполнения. Вложенная панель инструментов Fill Tool (Заливка) открывается при щелчке на кнопке инструмента Fill Tool (Заливка). Первая кнопка на этой панели открывает доступ к диалоговому окну Uniform Fill (Однородная), которое идентично окну Outline Color (Цвет абриса), рассмотренному выше. Последующие кнопки обеспечивают доступ к диалоговым окнам для соответствующих типов заполнения. Принципиально они организованы одинаковым образом: предлагается выбор из библиотек готовых вариантов заполнения, предоставляется возможность редактирования параметров заливки,[image: ] а в некоторых случаях (для градиентной и узорной заливок) — создание собственных моделей заполнения. Последняя кнопка в палитре инструментов Fill (Заливка) открывает стыкуемую палитру Color (Цвет) , автоматически «приклеивающуюся» к правой границе рабочего поля. С помощью средств этой палитры выбирают модель представления цвета в раскрывающемся списке, указывают нужный цвет и присваивают его контуру либо заливке объекта.

СРЕДСТВА МЕНЮ
[image: ]Некоторые инструментальные средства CorelDraw доступны только из меню, если пользователь не менял заданную по умолчанию конфигурацию в окне Options (Параметры). В частности, к ним относятся средства обработки растровых объектов, сосредоточенные в меню Bitmaps (Растровые изображения), средства преобразования, входящие в меню Effects (Эффекты), средства управления параметрами отображения из меню View (Вид), некоторые инструменты из меню Arrange (Упорядочить) и Tools (Сервис). Часть инструментальных средств и элементов управления можно открыть в стыкуемых палитрах. Однако принятая по умолчанию конфигурация интерфейса принципиального значения не имеет — пользователь всегда имеет озможность составить по своему усмотрению любые конфигурации панелей инструментов, меню и прочих элементов интерфейса.

СРЕДСТВА ПОЗИЦИОНИРОВАНИЯ
О программе CorelDraw тадиционно сложилось представление как о мощном и удобном средстве создания рекламных материалов, логотипов, иллюстративной и художественной графики. Действительно, именно в этих областях программа имеет самое широкое распространение. Однако не следует забывать о некоторых возможностях программы, превращающих ее в эффективное средство разработки инженерной и научной документации. С помощью CorelDraw можно создавать точные машиностроительные и архитектурные чертежи, строить графики, иллюстрировать учебные материалы. Для целей точного позиционирования объектов относительно рабочего листа и друг друга, управления проектом в целом и его отдельными элементами служат специальные средства CorelDraw.
Диалоговое окно Align and Distribute (Выровнять и распределить) открывается после щелчка на одноименной строке в меню Arrange (Упорядочить). На вкладке Align (Выравнивание) предлагаются средства выравнивания объектов относительно центра или края страницы, а также относительно других объектов или опорных точек направляющей сетки. На вкладке Distribute (Распределение) задают равномерное распределение объектов относительно других объектов или страницы документа. Управление выравниваем и распределением в сочетании с возможностью явно задавать размеры и положение объектов на панели свойств позволяет выполнять чертежи с точностью до третьего знака после запятой, что вполне достаточно для подавляющего большинства инженерных задач.
Управление объектами. Стыкуемая палитра Object Manager (Диспетчер объектов) является мощным средством управления положением объектов и контроля за их свойствами. Ее открывают из меню Tools > Object Manager (Сервис > Диспетчер объектов). В этой палитре представлено послойное расположение всех объектов с указанием их названий и свойств. Переход к любому объекту означает его автоматическую выборку с динамическим изменением элементов управления на панели свойств.
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Управление проектами. Дополнительные возможности по управлению сложными проектами предоставляет стыкуемая палитра Object Data (Сведения об объектах), где любому объекту можно присвоить собственное имя, назначить поля для его характеристик, например типа используемых материалов, стоимости работы и прочего. В целом средства управления проектом и объектами позволяют создать сложные многоуровневые документы и организовать совместную работу по их разработке.
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СОЗДАНИЕ И МОДИФИКАЦИЯ ОБЪЕКТОВ
Приемы рисования типовых объектов в CorelDraw мало отличаются от таковых в других векторных редакторах. Поэтому мы рассмотрим в основном возможности по манипуляции свойствами объектов и приемы их модификации стандартными средствами программы.
Все объекты, создаваемые инструментами программы, обладают рядом атрибутов и общими возможностями модификации. При выборе любого объекта инструментом Pick Tool (Указатель) на панели свойств отображаются поля с параметрами его координат (х, у), поля с параметрами размеров по горизонтали и вертикали, поля для установки масштаба (в процентах), кнопка разрешения (запрещения) пропорционального масштабирования, поле для задания угла поворота, кнопки инструментов зеркального отражения по вертикали и горизонтали. Состав прочих элементов управления зависит от типа конкретного объекта.

ОПЕРАЦИИ С ГРАФИКОЙ
Свойства линии. Для линии, создаваемой с помощью инструмента Freehand Tool (Кривая), до начала рисования на панели свойств могут быть заданы: форма наконечников, тип линии, ее толщина, степень сглаживания.
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Рис. 16.11. Свойства линии в режиме свободного рисования

Контур. Все линии представляют собой контур (открытый либо замкнутый). Кривую линию рисуют протягиванием мыши, прямую — щелчками в начальной и конечной точках. При нажатой клавише CTRL прямой можно задать фиксированный (с шагом 15°) угол наклона. Выбрав полученный объект инструментом Pick Tool (Указатель) по окончании рисования, получают доступ к редактированию его свойств.
Для открытой линии специфическим инструментом является средство Auto-Close Curve (Автоматическое замыкание кривой), соединяющее конечные точки и превращающее линию в замкнутый контур.
Узлы. Если объект выбран инструментом Shape Tool (Фигура), открываются возможности модификации его узловых точек. Для этого выбирают одну из точек и либо перемещают ее в нужное положение, либо воздействуют на управляющие касательные. Допустимые операции отображены на панели свойств. К ним относятся:
· добавление или удаление узловых точек: Add Node (Добавить узел) или Delete Node (Удалить узел);
· объединение двух точек: Join Two Nodes (Объединить два узла);
· разрыв линии в выбранной точке: Break Curve (Разъединить кривую);
· преобразование кривой в прямую и наоборот: Convert to Line (Преобразовать в линию) и Convert to Curve (Преобразовать в кривую);
· изменение формы кривой в данной точке: Cusp (Острый узел), Smooth (Сгладить узел), Symmetrical (Симметризовать узел);
· изменение направления линии: Reverse Curve Direction (Изменить направление);
· преобразование кривой в замкнутый контур путем соединения выбранных последовательно (с использованием клавиши SHIFT) конечных точек: Extend Curve to Close (Замкнуть кривую);
· вычленение отдельной кривой из объекта, представляющего собой комбинацию кривых: Extract Subpath (Извлечь фрагмент);
· автоматическое преобразование кривой в замкнутый контур: Auto-Close Curve (Автоматическое замыкание кривой);
· преобразование сегмента путем масштабирования, вращения и перекашивания сегмента, выравнивания узлов: Stretch and Scale Nodes (Масштабирование и растяжение узлов), Rotate and Skew Nodes (Поворот и наклон узлов), Align Nodes (Выравнивание узлов);
· включение режима «эластичных» (плавных) преобразований: Elastic Mode (Гибкий режим).
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Свойства узлов

Кривые Безье. Для линии, создаваемой с помощью инструмента BezierTool (Кривая Безье) до начала рисования могут быть заданы те же параметры, что и в предыдущем случае, за исключением параметра сглаживания. Приемы рисования: прямые линии создают щелчками в опорных точках (при нажатой клавише CTRL — с фиксированным углом наклона), для рисования кривых необходимо после щелчка слегка протянуть мышь от опорной точки. Дальнейшие способы модификации полученного объекта аналогичны изложенным ранее.
Художественные средства рисования. Инструмент Artistic Media Tool (Натуральное перо) имеет ряд интересных особенностей, позволяющих создавать своеобразные объекты. После щелчка на кнопке инструмента на панели свойств отображаются установки, принятые по умолчанию. То есть, до начала рисования инструментом считается перо (имитирующее плакатное), для которого можно установить степень сглаживания рисуемой линии, ее толщину и тип. Справа от кнопки заготовленных типов перьев последовательно расположены кнопки альтернативных инструментов: кисть, аэрограф, каллиграфическое перо, перо, чувствительное к нажиму. Последний инструмент работает только в сочетании с графическими планшетами, поддерживающими такую функцию.
[image: ]

 Свойства инструмента перо группы Artistic Media Tools

При выборе инструмента Brush (Натуральное перо фиксированной ширины) появляется возможность выбора типа кисти, при выборе каллиграфического пера — выбора угла его наклона. При выборе инструмента Аэрограф на панели свойств появляются дополнительные элементы: поля установки размеров элементов заполнения (по вертикали и горизонтали, в процентах от исходного размера) с кнопкой разрешения (запрещения) пропорционального масштабирования; список выбора типа заполнения; кнопки сохранения или удаления типа заполнения; список выбора порядка заполнения; кнопка добавления модифицированного заполнения к используемому типу; кнопка вызова диалогового окна модификации типа заполнения; счетчики установки интервала между столбцами и рядами элементов заполнения; кнопка изменения угла поворота элементов заполнения; кнопка выбора параметра смещения элементов заполнения; кнопка сброса всех внесенных изменений и возврата к значениям по умолчанию для данного типа заполнения.
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Свойства инструмента Sprayer

Свойства элементов оформления. Элементы заполнения в инструменте Brush (Натуральное перо фиксированной ширины) являются едиными объектами, и модифицировать можно только объект в целом. Объекты, созданные инструментом Sprayer (Аэрограф), можно разбивать на отдельные элементы: Arrange > Separate (Упорядочить > Разъединить), Arrange > Ungroup (Упорядочить > Отменить группировку) — и затем работать с каждым элементом как с отдельным объектом.
Размерные линии. При выборе инструмента проставления размеров Dimension Tool (Инструмент Размер) до начала рисования можно указать тип размерных линий: расставляемые автоматически, вертикальные, горизонтальные, наклонные, выносные и угловые. В раскрывающихся списках выбирают формат представления результатов измерения, точность представления данных, единицы измерения. В полях Prefix (Префикс) и Suffix (Суффикс) при необходимости проставляют текстовые или цифровые данные. Кнопкой Dynamic (Динамическое представление размерных линий) включают (отключают) режим динамического представления размещения данных во время выбора опорных точек. Раскрывающая кнопка Text Positioning Drop/Down (Положение текста) открывает доступ к кнопкам выбора позиции размещения проставляемых размеров.
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Свойства размерных линий

Прямоугольники. С помощью инструмента Rectangle Tool (Прямоугольник) создают прямоугольники. До начала рисования можно задать радиусы скругления любого из углов прямоугольника счетчиками Rectangle Corner Roundness (Округление углов прямоугольника). Рисование прямоугольника заключается в протягивании мыши от начального угла к противолежащему. Для рисования прямоугольника от центра надо удерживать клавишу SHIFT, для рисования квадрата — клавишу CTRL По завершении рисования параметры скругления углов можно изменить перетаскиванием их узловых точек или изменением значений в счетчиках. Прямоугольник является объектом, представляющим собой замкнутый контур. Поэтому на панели свойств появляются новые элементы, характерные для всех замкнутых контуров. Первым из них является раскрывающая кнопка Wrap Paragraph Text (Обтекание простым текстом), открывающая доступ к кнопкам выбора варианта размещения текстового блока внутри замкнутого контура. Вторым элементом является кнопка Convert to Curves (Преобразовать в кривые), преобразующая прямоугольник в обычный набор сегментов кривой. После такого преобразования узловые точки можно модифицировать так же, как и в любом другом контуре.
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Свойства прямоугольников

Эллипсы. Инструментом Ellipse Tool (Эллипс) рисуют эллипсы (и окружности как их частный случай). Приемы рисования аналогичны приемам рисования прямоугольника. По завершении рисования на панели свойств появляются новые элементы управления свойствами, характерные для эллипсов. Кнопка Pie (Сектор) позволяет интерактивно или изменением значений счетчиков Starting and Ending Angles (Начальный и конечный углы) задавать параметры сектора, вырезаемого из эллипса. Кнопкой Arc (Дуга) таким же образом задают параметры вырезаемой дуги. Кнопкой Clockwise/ Counterclockwise Arcs or Pies (Дуги и сектора по часовой стрелке/Против часовой стрелки) управляют размещением сектора (дуги) относительно узловых точек.
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Свойства эллипсов

Многоугольники. Инструмент Polygon Tool (Многоугольник) до начала рисования позволяет с помощью счетчика Number of Points on Polygon (Число вершин многоугольника) задать число углов многоугольника, движком установить параметр Sharpness of Polygon (Острота углов многоугольника), кнопкой Polygon/Star (Простой/ Звездчатый) выбрать соответствующую фигуру. Приемы рисования аналогичны приемам работы с другими инструментами создания геометрических фигур. После создания объекта его можно модифицировать стандартными способами. Дополнительно доступны средства изменения формы фигуры кнопкой Polygon/Star (Простой/ Звездчатый) и числа углов счетчиком Number of Points on Polygon (Число вершин многоугольника).
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Свойства многоугольников
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Спирали. Инструмент рисования спиралей Spiral Too! (Спираль) позволяет создавать как симметричные, так и логарифмические спирали. До начала рисования доступны счетчик установки числа витков спирали Spiral Revolution (Обороты спирали), кнопки выбора типа фигуры Symmetrical Spiral (Симметричная спираль) и Logarithmic Spiral (Логарифмическая спираль). Если выбрана логарифмическая спираль, активизируется движок Spiral Expansion Factor (Коэффициент расширения). Приемы рисования аналогичны рассмотренным ранее. По завершении рисования выбранная фигура представляет собой обычную кривую, состоящую из сегментов, и может редактироваться стандартными приемами.
                           Свойства спиралей
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Сетка. При работе с инструментом Graph Paper Tool (Разлиновать бумагу) до начала рисования можно задать число строк и столбцов счетчиками Graph Paper Columns and Rows (Строки и столбцы инструмента Разлиновать бумагу). Приемы рисования стандартные. Полученный объект представляет собой сгруппированные прямоугольники, расположенные по вертикали и горизонтали и образующие ячеистую структуру. Если разгруппировать такой объект: Arrange > Ungroup (Упорядочить > Отменить группировку), он распадается на отдельные прямоугольники, каждый из которых можно редактировать стандартным образом. Объект в целом также модифицируется обычными средствами.

ОПЕРАЦИИ С ТЕКСТОМ
Особое место среди средств CorelDraw занимает инструмент Text Tool (Текст). В то время как все другие инструменты работают с графическими объектами, текст не является графикой и потому обладает специфическими свойствами, например начертанием шрифта и прочими. Однако при необходимости любой текстовый объект может быть преобразован в графический: Arrange > Convert to Curve (Упорядочить > Преобразовать в кривые). А вот обратное преобразование невозможно.
Типы текстовых объектов. В CorelDraw текстовые объекты бывают двух типов. Первый тип текстовых объектов называется Artistic Text (Фигурный текст) и представляет собой свободно размещаемые строки текста. Второй тип называется Paragraph Text (Простой текст) и отличается размещением символов внутри текстового блока. Форму и границы блока можно модифицировать стандартными для графических объектов средствами, однако символы всегда будут находиться внутри него, а их редактирование (изменение свойств) возможно только инструментом Text Tool (Текст). Отличие объектов типа Artistic Text (Фигурный текст) состоит в том, что их можно модифицировать как графические объекты (например, вращать или растягивать) с воздействием преобразований на сами символы, что недопустимо для объектов блочного текста. Средство конвертирования текстовых объектов Text» Convert... (Текст > Преобразовать...) позволяет осуществлять взаимные преобразования между двумя типами тестовых объектов. При этом все изменения, внесенные в объект Artistic Text (Фигурный текст) средствами редактирования графики и повлиявшие на форму символов, автоматически отменяются (за исключением размера шрифта) во время преобразования в объект Paragraph Text (Простой текст).
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Объекты типа Artistic Text (слева) и Paragraph Text (справа)
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Набор и форматирование. Средства набора, форматирования и редактирования текста находятся в палитре свойств и в раскрывающемся меню Text (Текст) строки меню. Их состав аналогичен стандартным средствам текстовых редакторов и программ верстки. Однако имеются два специфических инструмента, не встречающиеся в специализированных программах обработки текста. Инструмент Fit Text to Path (Текст вдоль кривой) позволяет расположить текст вдоль линии. Для этого достаточно последовательно выбрать объект типа Artistic Text (Фигурный текст) и любой графический объект и применить инструмент. Можно также подвести текстовый курсор к кривой так, чтобы рядом с вертикальной чертой курсора появилась волнистая  линия, после чего можно щелкнуть мышью и начинать ввод текста. После создания совмещенного текстово-графического объекта на панели свойств появляются инструменты редактирования: раскрывающиеся списки Text Orientation (Ориентация текста), Vertical Placement (Вертикальное расположение), Text Placement (Положение текста), счетчики Distance from Path (Расстояние от кривой) и Horizontal Offset (Горизонтальное смещение), а также кнопка Place on Other Side (Размещение с другой стороны). Редактирование текстового содержимого возможно средствами инструмента Text Tool (Текст).
Другим специфическим инструментом работы с текстом является средство Fit Text to Frame (Вписать текст в рамку), позволяющее поместить текстовый блок внутрь замкнутого контура. При этом границы контура рассматриваются как границы блока. Для размещения текста внутри замкнутого контура достаточно выбрать инструмент Text Tool (Текст), подвести текстовый курсор к границе контура так, чтобы рядом с вертикальной чертой курсора появился значок в виде символов АВ в рамке. После щелчка мышью можно начинать ввод текста.
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Размещение текста внутри графического объекта

ОПЕРАЦИИ НАД СВОЙСТВАМИ ЗАПОЛНЕНИЯ ОБЪЕКТОВ
Неотъемлемым свойством замкнутых контуров (а в некоторых случаях и открытых) является метод заполнения (заливки). Простейшим способом выбора заполнения служит щелчок левой кнопкой на выбранном элементе цветовой палитры. Щелчком правой кнопкой мыши выбирают цвет контура. Другим способом является выбор цвета в стыкуемой палитре Color (Цвет) с последующим щелчком на кнопке Fill (Заливка). Следующий прием заключается в выборе объекта, открытии щелчком правой кнопкой мыши контекстного меню, выборе пункта Properties (Свойства) и выборе в открывшемся диалоговом окне вкладки Fill (Заливка), где можно указать метод заливки. Наконец, можно открыть диалоговое окно Uniform Fill (Однородная запивка) щелчком на кнопке Fill Tool (Заливка) панели инструментов и последующим щелчком на кнопке Fill Color Dialog (Диалог Однородная заливка) появившейся вложенной панели.
Средства заполнения. Заливку замкнутого контура удобнее всего выполнять инструментом Interactive Fill Tool (Интерактивная заливка). Например, для градиентного заполнения достаточно выбрать нужный цвет и затем протянуть курсор внутри контура в направлении действия градиента. На панели свойств при выборе инструмента Interactive Fill Tool (Интерактивная заливка) появляются соответствующие элементы управления.
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Элементы управления Interactive Fill Tool

К общим для всех методов заливки инструментам относятся: кнопка Edit Fill (Редактировать заливку), при щелчке на которой открывается диалоговое окно, соответствующее методу заливки; раскрывающийся список Fill Type (Тип заливки), содержащий все доступные в CorelDraw методы заполнения; раскрывающийся список Outline Width (Толщина абриса) и кнопка Copy Fill Properties (Копировать параметры заливки). Набор остальных средств зависит от избранного метода заполнения.
Сплошное заполнение. Для заполнения сплошным цветом можно выбрать цветовую модель в раскрывающемся списке Uniform Fill Type (Тип однородной заливки), а затем счетчиками выставить отдельные параметры, соответствующие типу цветовой модели. Например, для модели CMYK это будут процентные соотношения цветов ее палитры.
Градиентное заполнение. При выборе метода градиентной заливки Fountain Fill (Градиентная) на панели свойств появляются следующие элементы управления: кнопки типов градиентной заливки Linear Fountain Fill (Линейная градиентная заливка), Radial Fountain Fill (Радиальная градиентная заливка), Conical Fountain Fill (Коническая градиентная заливка), Square Fountain Fill (Квадратная градиентная запивка); раскрывающиеся списки для выбора начального и конечного цветов градиента First Fill Picker (Первый указатель заливки) и Last Fill Picker (Последний указатель заливки); счетчики Fountain Fill Midpoint (Средняя точка градиентной заливки), Fountain Fill Angle and Edge Pad (Угол и ширина градиентной заливки). После создания градиентной заливки ее параметры можно менять интерактивно путем перетаскивания элементов управления градиентом прямо на объекте.
Заполнение узорами. В случае выбора метода заполнения узорами Pattern Fill (Узор) появляются элементы управления в виде кнопок выбора модели заливки Two-Color Bitmap Pattern Fill (Запивка двуцветным растровым узором), Full Color Pattern Fill (Заливка полноцветным узором), Bitmap Pattern Fill (Заливка растровым узором); раскрывающегося списка с образцами моделей заполнения; раскрывающихся кнопок выбора цветов переднего и заднего плана Front Color (Цвет переднего плана) и Back Color (Цвет заднего плана), которые активны только для модели заливки Two-Color Bitmap Pattern Fill (Заливка двуцветным растровым узором); кнопок выбора размеров элементов заполнения Small Tile for Pattern (Мелкая мозаика для узора), Medium Tile for Pattern (Средняя мозаика для узора), Large Tile for Pattern (Крупная мозаика для узора); счетчиков изменения размеров элементов заполнения по вертикали и горизонтали Edit Tiling of Pattern (Изменить мозаику узора); кнопка включения (отключения) режима трансформации заполнения при модификации объекта Transform Fill With Object (Масштабирование узора с объектом); кнопка выбора объектов для их последующего использования в качестве узоров Select Pattern (Выбрать узор). После создания заполнения узором его можно редактировать в интерактивном режиме путем перетаскивания элементов управления на объекте.
Заполнение текстурами. Метод заполнения текстурами Texture Fill (Заливка текстурой) предлагает элементы управления в виде раскрывающегося списка библиотеки образцов Texture Library (Библиотека текстур), раскрывающегося списка выбора образцов First Fill Picker (Первый указатель заливки), кнопки Regenerate Texture (Восстановить текстуру), кнопки Texture Options (Параметры текстуры), открывающей доступ к одноименному диалоговому окну, где устанавливают разрешение (в точках на дюйм) текстуры и ограничения по размерам элемента текстуры (в пикселах) и объема ее файла. После создания заполнения его редактируют способами, описанными выше.
Заполнение PostScript. При выборе метода заполнения PostScript Fill (PostScript) появляется единственный элемент управления — раскрывающийся список для выбора образцов текстур PostScript Fill Textures (Заливка текстурой PostScript). Интерактивное редактирование текстур PostScript недоступно. При необходимости изменить параметры такой текстуры можно воспользоваться инструментом Fill Tool (Заливка), открыть щелчком на кнопке PostScript Fill Dialog (Диалог Заливка узором PostScript) диалоговое окно PostScript Texture (Заливка PostScript) и счетчиками изменить параметры заливки.
[image: ]
Применение инструмента
Interactive Mesh Fill
Редактирование заполнения. Инструмент Interactive Mesh Fill Tool (Интерактивная заливка по узлам) предназначен для интерактивного редактирования заполнения, уже присвоенного объекту. При выборе инструмента на панели свойств появляются элементы управления в виде счетчиков Grid Size (Размер сетки), с помощью которых текстура разбивается на необходимое число участков. Точки, располагающиеся на пересечении границ участков, обладают всеми свойствами стандартных узловых точек и операции над ними идентичны таковым для опорных точек. Тем самым, можно гибко менять структуру заполнения, добиваясь необходимого эффекта.
Редактирование прозрачности. Инструмент Interactive Transparency Tool (Интерактивная прозрачность) предназначен для динамического управления степенью прозрачности объекта. При его выборе на панели свойств появляется кнопка Edit Transparency (Редактирование прозрачности) и раскрывающийся список для выбора метода заполнения Transparency Type (Тип прозрачности). С помощью движков Starting Transparency (Начальная прозрачность) и Ending Transparency (Конечная прозрачность) управляют степенью прозрачности. В раскрывающемся списке Transparency Operation (Режим прозрачности) выбирают логические и иные операции над заливкой, кнопкой Freeze (Застывшая прозрачность) закрепляют сделанные изменения, а кнопкой Clear (Удаление прозрачности) отменяют все модификации.
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Свойства инструмента Interactive Transparency Tool

МОДИФИКАЦИЯ ФОРМЫ ОБЪЕКТОВ
Эффективными средствами изменения формы объектов выступают инструменты, объединенные в группе интерактивных инструментов, и альтернативные инструменты группы Shape Edit Tool (Фигура).
Перетекание (переходы). Для использования инструмента Interactive Blend Tool (Интерактивное перетекание) необходимо наличие в документе как минимум двух объектов (не считая текстовых). После выбора инструмента, но до его применения на панели свойств можно установить число промежуточных трансформаций с помощью счетчика Number of Steps or Offset Between Blend Shapes (Число шагов или смещение между фигурами в перетекании); выбрать направление трансформации кнопками Direct Blend (Прямое перетекание), Clockwise Blend (Перетекание по часовой стрелке), Counterclockwise Blend (Перетекание против часовой стрелки); установить параметры трансформации кнопками Object and Color Acceleration (Сгущение при перетекании), Accelerate Sizing for Blend (Сгущение размера при перетекании), Link Blend Acceleration (Связь сгущения при перетекании). Применение инструмента заключается в выборе первичного объекта и протягивании мыши ко вторичному объекту. Промежуточные объекты трансформации создаются автоматически. После завершения операции на панели свойств становятся доступны следующие элементы управления: счетчик Blend Direction (Направление перетекания); кнопка Loop Blend (Перетекание циклом); раскрывающиеся панели Miscellaneous Blend Options (Различные параметры перетекания), Start and End Object Properties (Свойства начального и конечного объектов), Path Properties (Свойства траектории), с помощью которых редактируют свойства полученного объекта.
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Свойства инструмента Interactive Blend Tool

Ореолы. Инструмент Interactive Contour Tool (Интерактивный ореол) предназначен для создания ореолов на основе выбранного объекта (исключая текстовые). При выборе инструмента до его применения на панели свойств доступны элементы управления направлением создания ореола: кнопки То Center (К Центру), Inside (Внутрь), Outside (Наружу); счетчик установки числа создаваемых контуров Contour Steps (Число шагов в ореоле); счетчик установки шага смещения контуров Contour Offset (Смещение контуров); кнопки управления направления смещения цвета ореола Linear Contour Colors (Цвета контуров по линии), Clockwise Contour Colors (Цвета контуров по часовой стрелке), Counterclockwise Contour Colors (Цвета контуров против часовой стрелки); раскрывающиеся панели выбора цвета контура и заполнения Outline Color (Цвет абриса) и Fill Color (Цвет заливки). Модификация объекта заключается в протягивании мыши в выбранном направлении. В дальнейшем параметры ореола можно редактировать, применяя перечисленные выше элементы управления.
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Свойства инструмента Interactive Contour Tool

Свободная деформация. Инструмент Interactive Distortion Tool (Интерактивное искажение) служит для свободной деформации объектов. После выбора инструмента на панели свойств появляются кнопки выбора типа деформации: Push and Pull Distortion (Искажение Толкать и Тянуть), Zipper Distortion (Искажение Зигзаг) и Twister Distortion (Искажение Смерч). В зависимости от выбранного типа деформации могут присутствовать и другие элементы управления. Для средства Push and Pull Distortion (Искажение Толкать и Тянуть) это счетчик установки размаха деформации Push and Pull Distortion Amplitude (Амплитуда искажения Толкать и Тянуть). Для средства Zipper Distortion (Искажение Зигзаг) это счетчики установки размаха и частоты деформации Zipper Distortion Amplitude (Амплитуда искажения Зигзаг) и Zipper Distortion Frequency (Частота искажения Зигзаг), кнопки включения параметров деформации Random Distortion (Произвольное искажение), Smooth Distortion (Сглаженное искажение) и Local Distortion (Местное искажение). Для средства Twister Distortion (Искажение Смерч) элементами управления являются кнопки выбора направления деформации Clockwise Rotation (Вращение по часовой) и Counterclockwise Rotation (Вращение против часовой), счетчик установки общего угла деформации объекта Complete Rotations (Полных вращений) и счетчик установки дополнительного угла деформации относительно выбранной опорной точки Additional Degrees (Добавочные градусы). После применения инструмента становится доступной кнопка включения деформации относительно центра объекта Center Distortion (Центровка искажения).
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Свойства инструмента Interactive Distortion Tool

Огибающая. Инструмент Interactive Envelope Tool (Интерактивная оболочка) позволяет модифицировать выбранные объекты в соответствии с формой огибающего их контура, создаваемого инструментом. То есть, вокруг объекта размещается управляющий объект, имеющий собственные опорные точки, перемещение которых вызывает перемещение расположенных вблизи узловых точек модифицируемого объекта. После выбора инструмента на панели свойств появляются элементы управления: кнопки выбора формы огибающей Envelope Straight Line Mode (Режим прямой линии оболочки), Envelope Single Arc Mode (Режим одинарной дуги оболочки), Envelope Double Arc Mode (Режим двойной дуги оболочки), Envelope Unconstrained Mode (Режим неспрямленной оболочки); кнопка Add New Envelope (Добавить новую оболочку) для фиксации изменений; раскрывающаяся панель Add Preset (Выбор и применение заготовки) для выбора готовых форм огибающих; раскрывающийся список Mapping Mode (Режим натяжки) для выбора режима действия огибающей; кнопка Keep Lines (Сохранить линии). Модификация объекта в соответствии с формой огибающей заключается в перетаскивании мышью выбранной узловой точки и настройке параметров на панели свойств.
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Свойства инструмента Interactive Envelope Tool

Выдавливание. С помощью инструмента Interactive Extrude Tool (Интерактивное выдавливание) создают псевдотрехмерные объекты путем «выдавливания» контуров (открытых или замкнутых). После выбора инструмента на панели свойств доступны кнопки переключения режима Bitmap Extrusion Mode (Растровый режим выдавливания) и Vector Extrusion Mode (Векторный режим выдавливания). При щелчке на первой кнопке появляются следующие элементы управления: счетчик установки глубины выдавливания Extrude Depth (Глубина), раскрывающиеся панели управления параметрами Front Bevel (Передний скос) и Back Bevel (Задний скос), раскрывающаяся панель выбора текстуры Texture (Текстура), раскрывающаяся панель выбора углов поворота объекта относительно осей координат Extrude Rotation (Вращение выдавливания), раскрывающаяся панель выбора источника рассеянного света Ambient Light (Рассеянный свет), раскрывающаяся панель Bevel (Скос), раскрывающся панель выбора точечного источника света Point Light (Точечное освещение), кнопка масштабирования объекта по размерам блока Fit to View (Подогнать).
В случае выбора режима Vector Extrusion Mode (Векторный режим выдавливания) формирование объекта происходит в интерактивном режиме путем протягивания курсора в выбранном направлении. По завершении операции на панели свойств появляются следующие элементы управления: раскрывающаяся панель выбора типа выдавливания Extrusion Mode (Тип выдавливания), счетчик установки глубины выдавливания Extrusion Depth (Глубина), счетчики установки координат (х, у) точки схождения линий объекта по третьей координате Vanishing Point Coordinate (Координаты точки схода), раскрывающийся список выбора свойств точки схождения Vanishing Point Properties (Свойства точки схода), кнопки переключения режима размещения точки схождения Position Vanishing Point Relative to Page Origin (Положение точки схода относительно начала страницы) и Position Vanishing Point Relative to Object Center (Положение точки схода относительно центра объекта), раскрывающаяся панель управления поворотом относительно осей координат Extrude Rotation (Вращение выдавливания), кнопка сброса значений углов поворота Reset Rotation (Сброс поворота), раскрывающаяся панель выбора способа закраски объекта Color (Цвет выдавливания), раскрывающаяся панель установки параметров фаски Bevels (Скосы выдавливания), раскрывающаяся панель установки параметров источников освещения Lighting (Подсветка выдавливания).
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Свойства инструмента Interactive Extrude Tool

Тени. С помощью инструмента Interactive Drop Shadow Tool (Интерактивная падающая тень) создают эффект тени, отбрасываемой объектом. После выбора инструмента необходимо протянуть курсор в направлении, куда будет помещена тень. По завершении операции на панели свойств становятся доступными следующие элементы управления: счетчик для установки параметров прозрачности тени Drop Shadow Opacity (Темнота падающей тени), счетчик для установки параметров размывки тени Drop Shadow Feathering (Оперение падающей тени), раскрывающаяся панель для выбора направления размытия Drop Shadow Feathering Direction (Направление падающей тени), раскрывающаяся панель для выбора параметров Drop Shadow Feathering Edges (Края падающей тени), раскрывающаяся панель для выбора параметров перспективы Drop Shadow Perspective Type (Тип перспективы падающей тени), поле ввода значений угла поворота тени Drop Shadow Angle (Угол падающей тени), поля с движками для ввода параметров Drop Shadow Fade (Ослабление падающей тени) и Drop Shadow Stretch (Растяжение падающей тени), раскрывающаяся панель для выбора цвета тени Drop Shadow Color (Цвет падающей тени).
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Свойства инструмента Interactive Drop Shadow Tool
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Нож. Инструмент Knife (Нож) служит для расчленения контуров на составляющие. Если пересечь контур инструментом, в точке пересечения образуется разрыв, то есть формируются две узловые точки, принадлежащие разным сегментам. Инструмент применим как к открытым, так и к замкнутым контурам. При выборе инструмента на палитре свойств появляется кнопка Leave as one Object (Оставить как один объект), управляющая режимом представления модифицируемого объекта как единого целого или с образованием независимых объектов, и кнопка Auto-Close on Cut (Автоматическое замыкание при отрезании), управляющая режимом автоматического соединения разомкнутых контуров.
Ластик. Инструмент Eraser (Ластик) применим как к контурам, так и к заливкам объектов. В первом случае контур, если он не пересекается инструментом, как бы выдавливается по границе поля инструмента, а при пересечении разрывается. Во втором случае в области действия поля инструмента свойства заливки меняются. Вокруг очищенной области создается собственный замкнутый контур. Таким образом, инструмент образует отдельный объект, вложенный внутрь модифицируемого. При выборе инструмента на палитре свойств появляется счетчик установки поля действия Eraser Thickness (Толщина ластика), кнопка выбора режима действия Auto-Reduce on Erase (Автоматически упрощать при стирании), кнопка переключения формы поля инструмента Circle/Square (Круг/Квадрат).
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Свойства инструмента Eraser

Свободная трансформация. Инструмент Free Transform Tool (Свободное преобразование) позволяет выполнять обычные операции модификации объекта (вращение, масштабирование, наклон и прочие), но более точно, чем инструмент Pick Tool (Указатель), за счет появления на палитре свойств дополнительных счетчиков и полей, в которых могут выставляться точные значения требуемых параметров трансформации.
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Свойства инструмента Free Transform Tool

Линза. Средство модификации Lens (Линза) выделено в отдельную группу и находится в собственной стыкуемой палитре Lens (Линза). В палитре объединены элементы управления для различных эффектов, применяемых к выбранному объекту (рис. 16.35). Например, к ним относится эффект «рыбьего глаза», то есть увеличения центральной части объекта с уменьшением коэффициента масштабирования по краям.
Перспектива. Средство создания эффекта перспективы доступно из меню: Effects > Add Perspective (Эффекты > Добавить перспективу). После его выбора на объект накладывается прямоугольная сетка из вспомогательных линий, имеющая в углах узловые точки. Инструментом Shape Tool (Фигура) перемещают узловые точки, добиваясь необходимого эффекта перспективы (рис. 16.36). При нажатой клавише CTRL перемещение происходит строго вдоль одной из осей вспомогательной сетки. При нажатом сочетании клавиш CTRL+SHIFT происходит одновременное одинаковое смещение узлов, расположенных на одной оси.
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              Стыкуемая палитра Lens          Моделирование перспективы

ОПЕРАЦИИ НАД ГРУППАМИ ОБЪЕКТОВ
К операциям над группами объектов относятся группировка Arrange > Group (Упорядочить > Группировать), комбинирование Arrange > Combine (Упорядочить > Комбинировать), а также логические операции пересечения (логическое «И»), отсечения (логическое вычитание), объединения (логическое «ИЛИ»). Логические операции доступны из строки меню: Arrange > Shaping (Упорядочить > Объединение) или из стыкуемой палитры Shaping (Объединение).
Группировка. Группировка объектов заключается в их выборке инструментом Pick Tool (Указатель) с последующей фиксацией взаимного расположения командой Group (Группировать). При этом свойства сгруппированных объектов не меняются. Допустима группировка с многократным вложением групп друг в друга. Обратная операция происходит пошагово — Ungroup (Отменить группировку) — или сразу над всеми отдельными объектами, сколько бы уровней вложения групп не существовало — Ungroup All (Разгруппировать все). Все команды группировки (разгруппировки) доступны на панели свойств или из меню Arrange (Упорядочить).
Комбинирование. Комбинирование — Arrange > Combine (Упорядочить > Комбинировать) — отличается от группировки тем, что в результате операции создается единый итоговый объект, наследующий свойства объекта, выбранного последним. Даже если объекты не соприкасаются друг с другом, комбинирование приводит к присвоению итоговому объекту свойств последнего объекта. Если объекты пересекаются, в зоне пересечения свойства заполнения меняются на значение «без заполнения». Обратная операция — Arrange > Break Apart (Упорядочить > Разъединить) — приводит к разъединению объектов с сохранением присвоенных им во время операции комбинирования свойств. Однако зона пересечения при этом вновь обретает исходные свойства заполнения, так как принадлежит уже разным объектам. Команда комбинирования доступна на панели свойств, команда разъединения — только из меню Arrange (Упорядочить).
Логические операции. Управление логическими операциями над объектами удобнее осуществлять из стыкуемой палитры Shaping (Объединение). Однако эти средства доступны также из меню: Arrange > Shaping (Упорядочить > Объединение).
Операция ИЛИ. Операция Weld (Объединение) соответствует логической операции «ИЛИ», Выбранные объекты образуют единый контур, свойства которого наследуются от объекта, выбранного последним. Если выбранные объекты не пересекаются, образуется итоговый единый объект, не имеющий общего контура, но также наследующий свойства последнего выбранного объекта. Если объекты не пересекались, возможна обратная операция Arrange > Break Apart (Упорядочить > Разъединить), но исходные свойства объектов при этом не восстанавливаются.
В палитре Shaping (Объединение) необходимо щелкнуть на кнопке Weld (Объединение). В окне будет показан образец результата операции. Флажками Source Object (Других объектов) и Target Object (Объекта назначения) в разделе Leave Original (Сохранять оригинал) можно выставить режим сохранения копий исходных объектов.
Операция вычитания. Операция Trim (Исключение) соответствует логическому вычитанию. Выбранные объекты должны иметь зону пересечения, потому что именно она вычитается из итогового объекта, выбранного последним. Исходные объекты не объединяются, их свойства не передаются. Объект-источник (выбранный первым) вообще не претерпевает никаких изменений. Обратная операция невозможна, и восстановление исходного состояния доступно только путем отмены команды: Edit > Undo (Правка > Отменить).
В палитре Shaping (Объединение) необходимо щелкнуть на, кнопке Trim (Исключение). В окне будет показан графический пример итога операции. Флажками Source Object (Других объектов) и Target Object (Объекта назначения) в разделе Leave Original (Сохранять оригинал) можно выставить режим сохранения копий исходных объектов.
Операция И. Операция Intersection (Пересечение) соответствует логической операции «И». Выбранные объекты должны иметь зону пересечения, потому что именно она остается в качестве итогового объекта. Исходные объекты исчезают. Итоговый объект наследует свойства объекта, выбранного последним. Обратная операция невозможна, и восстановление исходного состояния доступно только путем отмены команды: Edit > Undo (Правка > Отменить).
В палитре Shaping (Объединение) необходимо щелкнуть на кнопке Intersection (Пересечение). Флажками Source Object (Других объектов) и Target Object (Объекта назначения) в разделе Leave Original (Сохранять оригинал) можно выставить режим сохранения копий исходных объектов.
Объекты PowerClip. В программе CorelDraw существует особый класс объектов, называемый PowerClip (Обрезка). Такие объекты представляют собой объект-контейнер, в который могут быть вложены другие объекты в качестве содержимого. Допустимо многоуровневое вложение (до пяти уровней), то есть в любой объект-контейнер можно вложить другие контейнеры со своим содержимым. Все вложенные объекты сохраняют свои свойства, их можно редактировать любыми инструментами, извлекать из контейнера или перемещать в другой контейнер. Если контейнер превышает по размерам вложенный объект, последний отображается на фоне контейнера. В противном случае отображается только та часть вложения, которая помещается в рамки контейнера. Поверх отображается объект, размещенный последним. Распознать объект PowerClip позволяет сообщение в строке состояния, например: PowerClip Rectangle on Layer 1 (Прямоугольник (обрезка) Слой 1).
Доступ к операциям PowerClip возможен из меню Effects > PowerClip (Эффекты > PowerClip) или в стыкуемой палитре Object Manager (Диспетчер объектов). В первом случае необходимо выбрать объект-вложение, дать команду Effects > PowerClip > Place Inside Container (Эффекты > PowerClip > Поместить в контейнер) и указать курсором объект-контейнер.
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Отображение объекта PowerClip в стыкуемой палитре
                   Object Manager

В стыкуемой палитре Object Manager (Диспетчер объектов) щелчком правой кнопкой мыши необходимо выбрать имя объекта-вложения и перетаскиванием переместить его поверх имени объекта-контейнера. После отпускания кнопки мыши появляется всплывающее меню, в котором надо выбрать пункт PowerClip Inside (Поместить в контейнер).
Для редактирования вложенного объекта необходимо выбрать щелчком правой кнопки мыши в стыкуемой палитре Object Manager (Диспетчер объектов) имя объекта и в открывшемся всплывающем меню выбрать пункт Edit Content (Редактировать содержимое). Редактируемый объект для удобства можно перемещать в пределах рабочего поля. По завершении редактирования следует вновь щелкнуть правой кнопкой мыши на имени объекта и в открывшемся всплывающем меню выбрать пункт Finish Editing This Level (Завершить редактирование).
Извлечение содержимого контейнера происходит по той же методике, только в меню необходимо выбрать пункт Extract Content (Извлечь содержимое). Содержимое контейнера извлекается только целиком.

[bookmark: _Toc43451732]Практическое занятие

[image: 30]Упражнение 1. Настройка интерфейса CorelDraw 
и параметров документа

1. Запустите программу CorelDraw.
2. В открывшемся окне Welcome to CorelDraw (Добро пожаловать в CorelDraw) щелкните на кнопке New Graphics (Создать).
3. На панели свойств щелкните на кнопке Options (Параметры).
4. В открывшемся окне Options (Параметры) в разделе Workspace (Рабочая область) выберите строку Edit (Изменение). В разделе Duplicate Placement (Повторить положение) установите на счетчиках Horizontal (По горизонтали) и Vertical (По вертикали) значения 5 мм. В разделе Nudge (Смещение) установите счетчиком Nudge (Шаг смещения) значение 1 мм.
5. Раскройте раздел Document (Документ), выберите строку General (Общие), в раскрывающемся списке Display (Отобразить) выберите строку Enhanced View (Качественный). Выберите строку Grid (Сетка), установите переключатель Spacing (Интервал), в разделе Spacing (Интервал) установите счетчиками Horizontal place a grid line every (По горизонтали помещать точки сетки через) и Vertical place a grid line every (По вертикали помещать точки сетки через) значения 5 мм. Установите флажок Show Grid (Показывать сетку).
6. Выберите строку Styles (Стили). На вкладке Styles (Стили) в окне выберите строку Default Graphics (По умолчанию для графики), в строке Outline (Абрис) на правом поле щелкните на кнопке Edit (Изменить). В открывшемся окне Outline Pen (Атрибуты абриса) счетчиком Width (Толщина) установите значение 1 пункт, щелчком на кнопке ОК закройте окно.
7. На вкладке Styles (Стили) в окне выберите строку Default Artistic Text (По умолчанию для фигурного текста). На правом поле в строке Text (Текст) щелкните на кнопке Edit (Изменить). В открывшемся окне Format Text (Форматирование текста) на вкладке Font (Шрифт) в разделе Font Properties (Свойства шрифта) в раскрывающемся списке Font (Шрифт) выберите шрифт без засечек, например Arial Cyr. Счетчиком Size (Размер) установите величину кегля 12 пунктов. Перейдите на вкладку Align (Выравнивание), в разделе Alignment (Выравнивание) установите переключатель типа выравнивания Center (По центру). Щелчком на кнопке ОК закройте окно.
8. На вкладке Styles (Стили) в окне выберите строку Default Paragraph Text (По умолчанию для простого текста) и повторите действия, изложенные в пункте 7.

[image: ]

 Выбор параметров шрифта в окне Format Text

9. В окне Options (Параметры) раскройте пункт Page (Страница), перейдите на строку Size (Размер). Установите переключатели Normal Paper (Обычная бумага) и Portrait (Книжная). В раскрывающемся списке Paper (Бумага) выберите формат А4.
10. Вернитесь к разделу Document (Документ). Установите флажок Save options as defaults for new documents (Сохранить параметры, как действующие по умолчанию для новых документов) и все активизировавшиеся после этого флажки.
11.  Перейдите в раздел Workspace (Рабочая область), раскройте пункт Customize (Настройка), выберите строку Shortcut Keys (Клавиши быстрого вызова). На вкладке Shortcut Keys (Клавиши быстрого вызова) раскройте папку Editing Commands (Команды правки), которая находится внутри папки Edit &Transform (Правка и преобразование), выберите строку Duplicate (Дублировать). Установить курсор в поле Press new shortcut keys (Нажмите новые клавиши быстрого вызова) и нажмите сочетание клавиш CTRL+D.
12. В окне Options (Параметры) перейдите на строку Toolbars (Панели инструментов). В окне вкладки Toolbars (Панели инструментов) раскройте папку Align & Distribute (Выравнивание и распределение), которая находится внутри папки Arrange (Мон таж). В раскрывающемся списке Property Bar (Панели свойств) выберите строку Multiple Objects (Несколько объектов).
13. Щелчком на кнопке ОК закройте окно Options (Параметры).

[image: кнопка]В этом упражнении мы научились основным приемам настройки интерфейса программы и параметров документа, создали собственное сочетание «горячих» клавиш и элемент управления панели свойств, появляющийся при выборе нескольких объектов.


[image: 45]Упражнение 2. Составление схемы
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Возможный вид создаваемой схемы

1. Запустите программу CorelDraw.
2. В открывшемся окне Welcome to CorelDraw (Добро пожаловать в CorelDraw) щелкните на кнопке New Graphics (Создать).
3. Выберите инструмент Rectangle Tool (Прямоугольник), протягиванием нарисуйте прямоугольник. На панели свойств в полях Object Size (Размер объекта) установите размер по горизонтали 50 мм, по вертикали 20 мм. В поле у Object Position (Положение объекта) установите значение 270 мм.
4. Откройте окно Align and Distribute (Выровнять и распределить) командой Arrange > Align and Distribute (Упорядочить > Выровнять и распределить). В разделе Align to (Выровнять) установите флажок Center of Page (По центру страницы), в левой части окна сбросьте флажок Center (По центру). Щелчком на кнопке ОК закройте окно.
5. Выберите инструмент Text Tool (Текст). Щелкните на свободном поле страницы и наберите текст «Ректорат».
6. Выберите инструмент Pick Tool (Указатель). Удерживая в нажатом положении клавишу SHIFT, выберите последовательно текстовый объект и прямоугольник. На панели свойств щелкните на кнопке Align (Выровнять и распределить). В открыв шемся окне Align and Distribute (Выровнять и распределить) установите флажки Center (По центру) среди левых и верхних элементов управления выравниванием.
7. Инструментом Pick Tool (Указатель) выберите прямоугольник. Сделайте его дубликат, нажав сочетание клавиш CTRL+D. Щелчком левой кнопки мыши на белом цвете в палитре цветов присвойте дубликату значение заполнения.
8. Перетаскиванием переместите дубликат так, чтобы его координата у имела значение 230 мм. При необходимости выставьте это значение на панели свойств.
9. Инструментом Pick Tool (Указатель) последовательно выберите дубликат и исходный прямоугольник. На панели свойств щелкните на кнопке Align (Выровнять и распределить), В открывшемся окне Align and Distribute (Выровнять и распределить) установите флажок Center (По центру) среди верхних элементов управления выравниванием.
10. Выберите инструмент Text Tool (Текст). Переместите курсор к контуру дубликата так, чтобы рядом с ним появились символы АВ в рамке. После этого щелкните мышью и наберите текст «Факультеты». На панели свойств щелчком на раскрывающей кнопке Vertical Alignment (Выравнивание по вертикали) выберите вариант выравнивания Center (По центру).
11. Инструментом Pick Tool (Указатель) выберите дубликат. Приемом, описанном в пункте 7, создайте две его копии. Выберите первую копию и щелчком на кнопке То Back (Ниже всех) на панели свойств переместите ее на задний план. То же самое проделайте для второй копии.
12. Выберите копии дубликата, начиная с нижней. На панели свойств щелчком на кнопке Group (Группировать) сгруппируйте объекты. Щелчком на кнопке отражения по вертикали Mirror Buttons (Кнопка Зеркало) переверните полученный объект. Переместите сгруппированный объект курсорной клавишей ВНИЗ до значения координаты у, равного 222,5 мм.
13. Протягиванием инструмента Pick Tool (Указатель) выберите дубликат и его копии и сгруппируйте в один объект.
14. Повторив пункты 7,10 (набрав текст «Вспомогательные подразделения»), создайте новый объект с координатами х, у (45; 230).
15. Выберите инструмент Ellipse Too! (Эллипс), протягиванием нарисуйте эллипс с параметрами ширины и длины 50 и 20 мм соответственно.
16. Используя приемы, описанные в пункте 9, выровняйте эллипс по вертикали относительно соседних объектов — флажок Тор (По верхнему краю).
17. Используя приемы, описанные в пункте 5, наберите текст «Проректор».
18. Инструментом Pick Tool (Указатель) последовательно выберите текстовый объект и эллипс. Дайте команду Text > Fit Text To Path (Текст > Текст вдоль кривой). На панели свойств счетчиком Distance from Path (Расстояние от кривой) установите значение — 6 мм.
19. Выберите инструмент Interactive Connector Tool (Интерактивное соединение) и соедините с его помощью элементы схемы прямыми линиями.
20. Выберите инструмент Polygon Tool (Многоугольник), на панели свойств установите значение счетчика числа углов равным 8, протягиванием нарисуйте восьми угольник. Присвойте фигуре значение заполнения цветом 20% Black (Серый 20%).
21. Выровняйте восьмиугольник относительно группы объектов «Факультеты» по координате х по центру. Установить значение координаты у равным 170.
22. Используя изученные ранее приемы, разместите в центре восьмиугольника надпись «Кафедры».
23. Используя инструмент Connector Line Tool (Соединительная линия), соедините восьмиугольник с объектом «Факультеты».
24. Используя инструмент Interactive Drop Shadow Tool (Интерактивная падающая тень), протягиванием от центра фигуры создайте тень со следующими параметрами:
· координаты х, у (7; -5);
· Drop Shadow Opacity (Темнота падающей тени) = 50;
· Drop Shadow Feathering (Оперение падающей тени) = 15;
· Feathering Direction (Направление падающей тени) = Average (Средний);
· Perspective Type (Тип перспективы) = Flat (Плоский).
25. Применяя изученные приемы, завершите схему так, чтобы она соответствовала представленной на рис. 
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Мы научились создавать объекты различных типов, изменять их свойства, взаимно позиционировать, группировать и выполнять прочие операции с графикой и текстом.

[image: 45]Упражнение 3. Построение графика зависимости 
крутящего момента двигателя от числа оборотов
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 Вариант оформления графика

1. Запустите программу CorelDraw.
2. В открывшемся окне Welcome to CorelDraw (Добро пожаловать в CorelDraw) щелкните на кнопке New Graphics (Создать).
3. Выберите инструмент Graph Paper Tool (Разлиновать бумагу), на панели свойств установите значения счетчиков Graph Paper Columns and Rows (Строки и столбцы инструмента Разлиновать бумагу) по 20.
4. Протягиванием создайте объект с размерами 100x100 мм.
5. Щелчком правой кнопки мыши в палитре цветов на значении 20% Black (Серый 20%) задайте цвет контуров объекта.
6. Выберите инструмент BezierTool (Кривая Безье). Щелчками выше левого верхнего угла, в левом нижнем углу, правее правого нижнего угла объекта при нажатой клавише CTRL создайте прямые линии, пересекающиеся под прямым углом (для осей координат). На панели свойств выберите с помощью раскрывающих кнопок Start Arrowhead Selector (Выбор начального наконечника) и End Arrowhead Selector (Выбор конечного наконечника) окончания линии в виде стрелок.
7. Откройте стыкуемую палитру Object Manager (Диспетчер объектов) командой Window > Dockers > Object Manager (Окно» Закрепления > Диспетчер объектов). Двойным щелчком на имени линии войдите в режим редактирования объекта и измените имя на Coordinate. Таким же образом поменяйте имя второго объекта на Graph.
8. Инструментом Pick Too! (Указатель) выберите последовательно объекты Coordinate и Graph. Щелчком на кнопке Align (Выровнять и распределить) на панели свойств откройте окно Aiign and Distribute (Выровнять и распределить). Установите флажки Тор (По верхнему краю) и Left (По левому краю).
9. Выберите инструмент Text Too! (Текст). Щелкните на свободном месте страницы и введите текст «N, Нм». Перетащите текстовый объект к окончанию вертикальной координатной прямой. Таким же образом создайте текстовый объект «v, сек-1» и перетащите его к окончанию горизонтальной координаты. Изменение шрифта и позиций символов выполните в окне Format Text (Форматирование текста), открываемом командой Text > Format Text (Текст > Форматировать текст).
10. С помощью инструмента Text Too! (Текст) поставьте в начале координат цифру О, а под каждой пятой вертикальной линией объекта Graph цифры от 1000 до 4000. Выровняйте эти цифры по вертикали с использованием изученных приемов. Так же расставьте вдоль вертикальной координаты цифры от 100 до 400 и выровняйте их по горизонтали.
И. Выберите инструмент Bezier Tool (Кривая Безье) и щелчками мыши в точках с координатами х, у (800, 40; 1200, 80; 1600, 200; 2000, 300; 2600, 400; 3000, 360; 3600, 320) создайте линию.
12. Выберите инструмент Shape Tool (Фигура), выберите вторую опорную точкулинии, щелчком правой кнопки мыши откройте контекстное меню и щелкнитена строке То Curve (Преобразовать в кривую). Подобным образом преобразуйтеостальные точки, кроме первой.
13. Выберите предпоследнюю опорную точку кривой, щелчком правой кнопки мыши откройте контекстное меню, щелкните на строке Smooth (Сгладить узел). Подобным образом преобразуйте остальные точки, кроме первой и последней.
14. Выберите самую верхнюю точку (точку максимума), щелчком правой кнопки мыши откройте контекстное меню, щелкните на строке Symmetrical (Симметризовать узел). Затем, воздействуя на управляющие касательные, добейтесь того, чтобы узловая точка совпала с верхней точкой графика. Итоговый график должен соответствовать представленному на рис. 16.41.
Мы научились средствами CorelDraw создавать сложные графическо-текстовые документы для иллюстрирования физических процессов.
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Упражнение 4. Построение упрощенного чертежа разреза зубчатого колеса

1. Запустите программу CorelDraw.
2. В открывшемся окне щелкните на кнопке New Graphics (Создать).
3. Чертеж требует высокой точности графики. Поэтому необходимо поменять некоторые установки параметров документа. Щелчком на кнопке Options (Параметры) панели свойств откройте диалоговое окно Options (Параметры). Откройте раздел Document (Документ) и перейдите к строке Grid (Сетка). На вкладке Grid (Сетка) установите переключатель Frequency (Число линий), счетчиками выставьте значение 10 по горизонтали и вертикали. Установите флажки Show Grid (Показывать сетку) и Snap to Grid (Привязывать к сетке). Перейдите к разделу Guidelines (Направляющие), установите флажок Snap to Guidelines (Привязать к направляющим). Щелчком на кнопке ОК закройте окно.
4. Для задания габаритов чертежа следует создать направляющие линии. Установите указатель мыши на вертикальную измерительную линейку и протягиванием перетащите направляющую линию в область чертежа. На панели свойств счетчиком х выставьте значение 20 мм. Следующие линии выставьте в положение х = 70 мм и х= 100 мм. Вертикальные направляющие выставьте в положения у = 250 мм, у = 160 мм, у = 70 мм.
5. Прежде чем начинать рисование, надо задать толщину контуров, принятую по умолчанию. Щелчком на кнопке Outline Tool (Абрис) на панели инструментов откройте диалоговое окно Outline Pen (Перо абриса), установите флажок Graphics (Графика), щелчком на кнопке ОК закройте окно, в открывшемся диалоговом окне Outline Pen (Атрибуты абриса) в разделе Width (Толщина) в раскрывающемся списке единиц измерения выберите пункт millimeters (миллиметров), счетчиком Width (Толщина) выставьте значение 0,6. Щелчком на кнопке ОК закройте окно.
6. Выберите инструмент Rectangle Tool (Прямоугольник), нарисуйте прямоугольник размером 50x90 мм с координатами центра х, у (45; 115). Откройте стыкуемую палитру Object Manager (Диспетчер объектов) командой Window > Dockers > Object Manager (Окно> Закрепления > Диспетчер объектов), присвойте прямоугольнику имя 01. Щелчком правой кнопки мыши на палитре цветов присвойте контуру цвет Red (Красный).
7. На панели свойств щелчком на кнопке Rounds Corners Together (Скруглять углы синхронно) отключите режим взаимосвязанного изменения радиусов закругления углов. Счетчиками Left Rectangle Corner Roundness (Скругление левых углов прямоугольника) и Right Rectangle Corner Roundness (Скругление правых углов прямоугольника) выставьте значение 10 для нижних углов.
8. Нарисуйте прямоугольник  размером 50x70 мм с координатами центра х, у (45; 115). Присвойте ему имя 02.
9. Нарисуйте прямоугольник размером 20x50 мм с координатами центра х, у (30; 115). Присвойте ему имя 03. Выставьте значение скругления его правых углов 20. Дав команду Effects > Add Perspective (Эффекты > Добавить перспективу), измените перспективу перетаскиванием нижней правой управляющей точки (при нажатом сочетании клавиш CTRL+SHIFT) по вертикали до появления в строке состояния Vanishing Point (Hoz) (Точка схода (гор)) значения 461 мм.
10. Создайте дубликат прямоугольника 03 (CTRL+D), зеркально отразите его по горизонтали, установите координаты центра х, у (60; 115), присвойте объекту имя 04.
11. Нарисуйте прямоугольник размером 30x10 мм с координатами центра*,у (85; 145), выставьте значение скругления правого нижнего угла 60, присвойте ему имя 05. Дав команду Effects > Add Perspective (Эффекты > Добавить перспективу), измените перспективу перетаскиванием нижней правой управляющей точки по вертикали до появления в строке состояния значения Vanishing Point (Hoz) (Точка схода) примерно 255 мм.
12. Откройте стыкуемую палитру Shaping (Объединение) командой Window > Dockers Shaping > Weld (Окно > Закрепления > Преобразование > Объединение). Выберите прямоугольник 05. Щелкните на кнопке Weld To (Объединение с) и укажите прямоугольник 02. Назначьте контуру итогового объекта цвет Green (Зеленый), оставьте имя 02.
13. Выберите прямоугольник 04, в стыкуемой палитре Shaping (Объединение) переключитесь в режим Trim (Пересечение), сбросьте все флажки Leave Original (Сохранить оригинал), щелкните на кнопке Trim (Пересечение с), укажите объект 02.
14. Повторите операцию (см. п. 13) с прямоугольником 03.
15. Выделите все объекты, сделайте дубликат, отразите его зеркально по вертикали, переместите дубликат в положение х, у (60; 205).
16. Выберите прямоугольник 01, дайте команду Weld To (Объединить с) и укажите дубликат прямоугольника 01. Присвойте дубликату объекта 02 имя 02а.
17. Нарисуйте прямоугольник размером 80x20 мм с координатами централ:, у (60; 160), присвоить ему имя 06, назначьте цвет контура Cyan (Голубой).
18. Нарисуйте прямоугольник размером 80x3 мм с координатами централт, г/ (60; 171,4), присвойте ему имя 07, назначьте цвет контура Cyan (Голубой).
19. Последовательно выберите прямоугольники 06 и 07 и скомбинируйте их. Присвойте заполнению цвет White (Белый). Присвойте итоговому объекту имя 08.
20. Выберите объекты 02 и 02а, продублируйте их, присвойте заполнению цвет White (Белый), переместите на задний план командой Arrange > Order > To Back (Упорядочить > Порядок > Ниже всех), переместите их в положением, у (60; 160), сгруппируйте объекты, присвойте результату имя Group 01. Выберите объект 01, переместите его на задний план. Сгруппируйте объекты 02 и 02а, присвойте результату имя Group 02. Командами Arrange > Order (Упорядочить > Порядок) разместите объекты в следующей последовательности (сверху вниз): 08, Group 02, Group 01, 01.
21. Выберите объект Group 01, щелчком на кнопке Fill Tool (Заливка) на панели инструментов откройте вложенную панель и щелчком на кнопке PostScript Fill Dialog (Диалог Заливка узором PostScript) откройте окно PostScript Texture (Заливка PostScript). Выберите строку Hatching, счетчиками установите параметры: Мах distance (Максимальное расстояние) = 50, Min distance (Минимальное расстояние) = 50, Line width (Ширина линии) = 5, Angle (Угол) = 45, Random seed (Случайный отсчет) = 0.
22. Инструментом Bezier Tool (Кривая Безье) проведите линию длиной 100 мм с координатами х, у (60, 160). На панели свойств установите ее свойства: Width (Толщина) = 0,353 мм; Outline Style Selector (Выбор стиля абриса) — штрих-пунктир.
23. Инструментом Bezier Tool (Кривая Безье) проведите линию длиной 60 мм с координатами х, у (45,245). На панели свойств задайте ее свойства: Width (Толщина) = 0,353 мм; Outline Style Selector (Выбор стиля абриса) — штрих-пунктир. Создайте такую же линию с координатами х, у (45; 75).
24. Выберите все объекты, присвойте контурам цвет Black (Черный), сгруппируйте объекты. При необходимости сохраните чертеж под именем, указанным инструктором.
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